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*************************************************************************** 

NOTE:  
Screen shots and data in this job aid are examples only to illustrate functionality and may not 
exactly reflect the actual screens or client-specific configurations.    

*************************************************************************** 

 

For Questions and Support 

• Contact your employer (supplier) or the SAP Fieldglass Help Desk. 

• Job aids and other materials are found by clicking Help – Question Mark icon and 
selecting Reference Library. 
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SAP FIELDGLASS REGISTRATION 
Before beginning an assignment, you receive an email invitation to register for the SAP 
Fieldglass application you use to record your time and expenses.  You must activate your SAP 
Fieldglass account before you can enter time sheets or expense sheets data.  Use the following 
instructions to activate your SAP Fieldglass account and begin using the application to record 
your time and expenses.   
 
1. Once you receive the registration email, click Create Your Account to access the 

registration site.   
 

  

 
2. Complete the fields on the Create Your Account screen.   
3. If required, a Security ID is provided either in a second email or is given to you by your 

employer (supplier).  Refer to your Worker’s Program Guide for more details. 
4. Once the fields are complete, click Sign In. 
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5. Your registration is complete.  Now you can set Preferences.  After selecting your 
preferences, click Save.  Note:  You receive this screen every time you log in.  To turn this 
off, select Don’t show this window again check box in the bottom left. 
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6. The Time Sheets instructions screen appears.   After reviewing the steps, click Next.  Note:  

You receive this screen every time you log in.  To turn this off, select Don’t show this 
window again check box in the bottom left. 
 

 

 
7. The Expense Sheets instructions screen appears.   After reviewing the steps, click 

Continue to SAP Fieldglass.  Note:  You receive this screen every time you log in.  To turn 
this off, select Don’t show this window again check box in the bottom left. 
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LOGGING IN TO SAP FIELDGLASS 
Follow the steps below to log into SAP Fieldglass: 

 

1. Go to URL: https://www.fieldglass.net 
2. Enter your Username and Password. 
3. Click Sign In. 

 

 

 
4. If you have forgotten your password, click the Need help signing in? link.   

 
 

 

NAVIGATION OVERVIEW 
The Desktop page is the starting point for you within SAP Fieldglass.   
 

 

 
  

https://www.fieldglass.net/
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From the left-side of the Desktop page, you can: 

 

• Create Expense Sheet This area allows you to create an expense sheet. 
 

 

 
• Create Absence This area allows you to indicate if you are unable to work.  Note, this 

functionality must be configured for your client, you may not see this.   
 

 

 
• View Time Sheets This area allows you to view all your submitted time sheets. 

 

 
 

• Select Favorite Tasks This area allows you to indicate if there are tasks you want to see 
every week on your timesheet.  This applies to you if you are working on multiple tasks (aka 
projects, cost centers, etc.).  
 

 
 

• My Profile and My Preferences  This area shows your user profile.  Go here to change 
your password, change your email address and make other updates to your user profile.  
Click Your Name and select either the My Profile or My Preferences link.  Click Sign Out 
to exit SAP Fieldglass. 
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• Work Items to Act Upon Work Items are tasks that need your attention such as completing 
a time sheet.  
 

  

 
• Main Menu 

 

 
 

o Home icon – returns you to the Desktop 

o View – allows you to view your time sheets, expense sheets and / or milestones 

o Create –  allows you to create an expense sheet 

 

• Help 

o Help - Question Mark icon – the Help menu allows you to access SAP Fieldglass 
Help and your Reference Library on Online Help. 
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TIME SHEET ENTRY 
Hours Worked Entry 
 
At the beginning of each time entry period, a time sheet is sent to your Desktop as a Work Item 
to Act Upon.  Note, this is applicable: 

• If you are in a State that requires a different type of time entry; such as, California, you 
must enter time using the Time In / Time Out format.  Please see the section on how to 
enter time in the Time In / Time Out format below. 

• If you are on a daily job, report your time using the standard hourly timesheet.  
Regardless of the number of hours entered per day, your time is calculated as a one day 
unit. 

 
1.  Click the Complete Time Sheet link to open the time sheet you wish to enter hours worked 

for.  
 

  

 
2. If your timesheet includes tasks, select the task(s) you worked on for this work week.   

a. Note, if you are not presented with this screen your manager did not assign you 
any tasks.  If you should have tasks and are not seeing any, reach out to your 
manager.   

b. Note:  you can make a task(s) a favorite.  When marked as a favorite a task 
always displays on your timesheet which eliminates a step.  This is applicable if 
you work on multiple tasks (which would be projects, cost centers, lines, etc.) 
throughout the week.  Refer to the Selecting a Task as a Favorite section of 
this document for steps.   
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3. Click the appropriate check box(s), and select Continue. 
 

 
 

4. The Enter Time Sheet page displays for that time period.   
5. Enter hours in the ST/Hr row for straight time.  Total hours automatically calculate in the 

Total column.  If you work overtime, allocate those hours into the OT/Hr row.   
 

 

 
6. If your hours are to be divided and allocated to multiple cost centers, enter the appropriate 

number of hours in the appropriate cost center section. 
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7. If you are entering hours worked in a shaded day (weekend, holiday) you receive a warning 
pop up alerting you.  Confirm the correct hours by clicking Submit. 
 

 
 

 

 
8. Add any Comments, if needed. 
9. Add any attachments by clicking the Add Attachments link. 
10. Click Complete Later to save the time sheet and come back to it later or once finished, click 

Submit to submit your time sheet for approval.  Note:  Your session times out after 15 
minutes of inactivity.  Click Complete Later to avoid losing your work if you are not ready to 
submit your time sheet. 
 

 

 
11. Once submitted, your time sheet goes through the approval process.  If your time sheet is 

rejected, you receive an email notification; you must correct your time sheet and re-submit it 
by following the steps listed above. 

12. A submitted timesheet can be edited if it has not been approved yet.  Open the Pending 
Approval timesheet, click Withdraw, make the necessary changes and click Submit. 
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Time In / Time Out Entry 
Some assignments or work locations require time to be captured by the actual time you started 
and stopped.  This is common in California, New York and Puerto Rico, as your assignment 
might be subject to different overtime and double time calculations.  To enter time when a time 
sheet captures both Time In and Time Out: 
 
1.   Click the Complete Time Sheet link to open the time sheet you wish to enter hours worked 

for. 
 

 

 
2. If your timesheet includes tasks, select the task(s) you worked on for this work week.  Note, 

if you are not presented with this screen, your manager did not assign you any tasks.  If you 
should have tasks and are not seeing any, reach out to your manager.   

3. Click the appropriate check box(s), and select Continue. 
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4. The Enter Time Sheet page displays. 
 

 

 
5. Enter the Time In, Meal Break Out, Meal Break In and Time Out for each day.   
6. To copy the previous day’s hours, click the Copy icon in the date section. 
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7. Enter your total hours in the Billable section.  If your hours are to be allocated to multiple 
cost centers, enter the appropriate number of hours in the appropriate cost center section. 

8. Enter any hours in the Non-billable section, if applicable. 
 

 

 
9. If you are entering hours in a shaded-out day (weekend, holiday) you receive a warning pop 

up alerting you.  Confirm the correct hours are entered by clicking Submit.  
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10. Click Complete Later to save the time sheet and come back to it later or once finished, click 
Submit to submit your time sheet for approval.  If your time sheet is rejected, you receive an 
email notification; you must correct your time sheet and re-submit it by following the steps 
listed above.   
 

  

 
11. A submitted timesheet can be edited if it has not been approved yet.  Select View > 

Timesheets from the Main Menu.  Open the Pending Approval timesheet, click Withdraw, 
make the necessary changes and click Submit. 
 

  
 
 

 

Daily Time Entry 
 
If your work order / assignment is based on Daily rates (most common in United Kingdom and 
some EMEA countries) you need to enter the hours actually worked in the correct row.  A time 
sheet is sent to your Desktop as a Work Item to Act Upon.   
 
1.  Click the Complete Time Sheet link to open the time sheet you wish to enter daily time for. 
 

 

 
2. If your timesheet includes tasks, select the task(s) you worked on for this work week.   

a. Note, if you are not presented with this screen your manager did not assign you 
any tasks.  If you should have tasks and are not seeing any, reach out to your 
manager.   

b. Note:  you can make a task(s) a favorite.  When marked as a favorite a task 
always displays on your timesheet which eliminates a step.  This is applicable if 
you work on multiple tasks (which would be projects, cost centers, lines, etc.) 
throughout the week.  Refer to the Selecting a Task as a Favorite section of 
this document for steps.   
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3. Click the appropriate check box(s) and select Continue. 
 

 
 

4. Depending on the configuration, you either 
a. enter a 0.25, 0.5, 0.75 or 1.00 value in the in the ST / Day field for each day 

worked.  
b. enter hours in the ST / Day field for each full day worked that.  Total hours 

automatically calculate in the Total column.   
c. Refer to your Program Guide, located in the Help > Reference Library for 

additional details of which format to use. 
d. Note:  If configured for half days (rare), if you worked a half day, enter the 

number of hours in the Half Day / Day row as appropriate (not pictured).  
5. If your hours are to be divided and allocated to multiple cost centers, enter the appropriate 

number the value or hours in the appropriate cost center section. 
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6. If you are entering hours worked in a shaded out day (weekend, holiday) you receive a 
warning pop up alerting you.  Confirm the correct hours by clicking Submit. 
 

 
 

 

 
7. Add any Comments, if needed. 
8. Add any attachments by clicking the Add Attachments link. 
9. Click Complete Later to save the time sheet and come back to it later or once finished, click 

Submit to submit your time sheet for approval.   
10. When finished, click Submit to submit your time sheet for approval.  If your time sheet is 

rejected, you receive an email notification; you must correct your time sheet and re-submit it 
by following the steps listed above. 
 

 

 
11. A submitted timesheet can be edited if it has not been approved yet.  Open the Pending 

Approval timesheet, click Withdraw, make the necessary changes and click Submit. 
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Monthly Hours Worked Entry 
 
In the rare case you enter time for an entire month before submitting it, at the beginning of each 
month, a monthly time sheet is sent to your Desktop as a Work Item to Act Upon.   
 
1.  Click the Complete Time Sheet link to open the time sheet you wish to enter hours worked 

for. 
 

 

 
2. If your timesheet includes tasks, select the task(s) you worked on for this work week.   

a. Note, if you are not presented with this screen your manager did not assign you 
any tasks.  If you should have tasks and are not seeing any, reach out to your 
manager.   

b. Note:  you can make a task(s) a favorite.  When marked as a favorite a task 
always displays on your timesheet which eliminates a step.  This is applicable if 
you work on multiple tasks (which would be projects, cost centers, lines, etc.) 
throughout the week.  Refer to the Selecting a Task as a Favorite section of 
this document for steps.   

 
3. Click the appropriate check box(s) and select Continue. 
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4. The Enter Time Sheet page displays for that month.   
5. Week 1 is selected (in blue).  To change the week you want to enter hours worked, click the 

respective button. 
 

  

 
6. Enter hours in the Standard Time / Mo field for each day of that week.  Total hours 

automatically calculate in the Total column.   
7. If your hours are to be divided and allocated to multiple cost centers, enter the appropriate 

number of hours in the appropriate cost center section. No Standard Time / Mo Option 
 

 
 

8. If you are entering hours worked in a shaded out day (weekend, holiday) you receive a 
warning pop up alerting you.  Confirm the correct hours by clicking Submit. 
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9. Add any Comments, if needed. 
10. Add any attachments by clicking the Add Attachments link. 
11. Click Complete Later to save the time sheet and come back to it for the upcoming weeks. 
12. When finished for the month, click Submit to submit your time sheet for approval.  If your 

time sheet is rejected, you receive an email notification; you must correct your time sheet 
and re-submit it by following the steps listed above.   
 

 

 
13. A submitted timesheet can be edited if it has not been approved yet.  Open the Pending 

Approval timesheet, click Withdraw, make the necessary changes and click Submit. 
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TIMESHEET APP 
 
SAP Fieldglass has a mobile app for both Android and IOS.  To use the SAP Fieldglass Time 
Entry mobile app, you must already be a registered worker in the SAP Fieldglass system and be 
able to log in using a username and password.  To do this: 
 

1. You must register in Fieldglass first using the steps in the registration section above.  
2. Download the app from Google Play or the App Store. 
3. Enter time using the mobile app.  Refer to the Google Play or App Store sites for more 

details.    
 

 
 

 

 

SELECTING A TASK AS A FAVORITE 
Your timesheet may be comprised of tasks.  They could be projects, cost centers, etc. where 
you work or items you work on during the week.  There may be times where you want a task(s) 
to always appear on your timesheet or when you want to not see a task on a timesheet.  You do 
this by indicate which task(s) is a favorite.  To select a task(s) as a favorite:   
 
1. Click Select Favorite Tasks under the Main Menu bar. 
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2. The Select Favorite Tasks screen displays.   
3. If no tasks display, select the Click Here link towards the top and pick which ones you want 

to make your favorites and click Add.   
4. Any tasks that currently are favorites display.  To add them to your current timesheet and all 

future timesheets, click the check box(es).   
5. Click Add Selected and then click Update.   

 

 

 
6. When you navigate to the timesheet, the favorite tasks display and are available to enter 

hours worked against.    
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CREATE A TIME SHEET REVISION 
The revised time sheets feature allows a worker to correct errors on a time sheet that has been 
approved and invoiced.  Note: This function may or may not be turned on for your client.  To 
revise an approved time sheet: 
 
1. Click View > Time Sheets from the Main Menu bar. 

 

  

 
2. The Time Sheet List displays.  The time sheet to revise must be in Approved status.   
3. Select the time sheet ID link. 

 

 

 
4. The time sheet opens.   Verify the Status is Approved. 
5. Click Actions > Revise.  Note, if you do not have the Actions > Revise button, this 

functionality is not turned on for your client.  Contact your employer (supplier) to report any 
revisions to an already approved time sheet. 
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6. Revise the hours worked to reflect exactly what you worked.   Note: the screenshot below 
displays the hours worked time sheet style, if you are using a time in / time out style your 
view is different. 
 

 

 
7. Select the Reason for the revision. 
8. Enter any comments, if necessary, in the Comments field.   
9. Add any attachments by clicking the Add Attachments link. 
10. Click Submit when complete.   
 

 
 

The time sheet goes to the appropriate reviewer for approval.   
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EXPENSE SHEET ENTRY 
To create an expense sheet: 
 
1. From the Desktop, click Create Expense Sheet. 

 

  

 
2. Select the appropriate Expense Code (such as meals, airfare, tolls, etc.).  If the code is not 

viewable, select the Click here link to find additional expense codes. 
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3. Enter the Date of the expense transaction, the Merchant, the Amount and the Description.   
4. To attach a scanned receipt for this particular entry, click the paper clip icon.  Note:  check 

with your employer (the supplier) to determine if you need to upload each receipt individually 
or if you can do it once at the end (see additional steps below). 

5. To enter additional line items, click either Copy (next to the date) or select the Expense 
Code (above) link for each additional item. 

 

 

 
6. Enter comments, if necessary, in the Comments field.   
7. Click the Add Attachments link to upload the scanned copy of your receipt(s), if you did not 

attach them individually. 
 

 

 
8. Click Choose File to locate the file.  Once done, click Attach. 
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9. Click Complete Later to save your expense sheet and come back to it later.  Click Submit 

to submit your expense sheet for approval.  Note: Your session times out after 15 minutes 
of inactivity.   
 

 
 
 

 

ABSENCE ENTRY 
If setup for your client, you can indicate any absences and why.  To indicate an absence:   
 
1. From the Desktop, click Create Absence. 

 

 

 
 
 
 
 
 
 
 

4 
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2. Complete all necessary fields.   When finished, click Submit. 
 

  
 
 

ONBOARDING ACKNOWLEDGEMENT 
If setup for your client (rare), you may need to complete and sign certain onboarding documents 
prior to you beginning work at the client.  To complete any onboarding items:   
 
1. From the Work Items to Act Upon section, click the Information / Reason link of the item 

you need to acknowledge. 
 

 

 
2. You may need to print, sign and upload the completed document.  Click the Upload link and 

follow all on screen directions. 
3. When that is complete, click Mark as Complete.  
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The Mark as Complete pop-up window displays.  Confirm / update the Completion Date and add 

and necessary Comments. 

4. Click Mark as Complete. 
 

  
 
 


